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Preface   

Audience 

This guide is intended for users of the BigFix Web Reports application. Most users will be interested in 
generating and printing out reports, but some users will be authorized to generate new custom reports. 

This guide encompasses all the features of the Web Reports Interface. Advanced topics in relevance and the 

low-level report language are beyond the scope of this document. For more information on these topics, see 
the BigFix Relevance Language Reference and the Inspector Guides. 

Organization of this Manual 

This document addresses the reporting features and the configuration settings for the Web Reports program. 

There are three major areas of discussion: 

• Overview. This chapter provides details on pre-existing reports that convey a high-level view of the 

health of the network. 

• Creating, Managing, Scheduling, and Filtering Reports. These chapters show you how to create, and 

manage your reports. 

• Configuring Email, Databases, and User Privileges. These chapters show you how to configure the 

overall Web Reports environment. 

Conventions Used in this Manual 

This document makes use of the following conventions: 

Bold Sans Bold sans-serif font is used for headings.  

Bold   Bold font indicates labels and field names in the Web Reports user interface.  

Italics   Italics are used for BigFix document titles. 

Mono-space  Mono-space font is used for sample programs and scripts. 

Versions 

This document describes functionality available in BigFix Web Reports version 7.0.4. 
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Introduction 

BigFix Web Reports is a web application. It connects to one or more BigFix Enterprise databases, analyzes the 

data gathered from these databases, and provides a visual display of the data. 

Requirements 

Web Reports can run on a stand-alone server or on the same machine that hosts the BigFix database. The 

requirements for the Web Reports server vary depending on the number of databases, computers, actions, and 

retrieved properties you wish to track.  

The Web Reports primary resource requirements revolve around memory size for fast access and CPU speed 
for fast report processing. The disk stores a local cache to make load times faster, but the disk speeds have less 

impact on the Web Reports than memory size and CPU speeds. 

BigFix deployments with more than 30,000 agents can benefit by having a separate Web Reports server so that 
the main BigFix Server does not need to share its resources. You can set up multiple Web Reports servers with 

minimal performance impact on the main BigFix Server. 

Web Reports Server requirements: 

Number of BigFix Agents CPU Memory 

< 10,000 2ghz   1 GB 

10,001-30,000 2ghz (dual core) 2 GB 

30,000-100,000 2ghz (dual core) 3 GB 

100,000-200,000 2ghz (quad core) 4 GB 

 

The client browser requires Internet Explorer v. 6.0 or Mozilla Firefox. In order to view the graphs, you also 

need Adobe Flash Player version 9 or higher. 
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Viewing Web Reports 

BigFix Web Reports is divided into several sections.  

The left navigation bar provides links for quick access to reports you designate as Favorites and visited pages. 

 

The top navigation provides links to view the Overview, Reports, Create, Schedule, Email, Users, or 

Database page: 

 

• The Overview section contains graphs and statistics that convey a general, high-level sense of the health 

of the network. 

• The Reports section offers shortcuts to previously generated reports and links to external reports outside 

of the Web Reports application. It also allows you to select useful reports to be placed in the “Favorites” 
section for quick access. 

• The Create section allows you to create basic reports that are capable of analyzing specific parts of the 

network based on certain criteria. These reports can be stored for viewing at a later date, viewed in a 

printer-friendly format, or saved in a format that can be imported into Excel or an equivalent spreadsheet 

application. 

• The Schedule section allows you to run reports at a given time or when certain conditions are met. The 

report results can then be emailed to you or archived for later viewing. 

• The Email section configures the email server settings, and allows you to edit your email addresses. 

• The Users section handles Web Reports user management: adding, deleting, and editing users. 

• The Database section takes care of BigFix database management. This includes adding, deleting, and 

editing database connections and settings.  

The following chapters will discuss each of these sections in greater detail. 
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Overview 

The BigFix Web Reports Overview page contains graphs and tables that visually represent the overall state of 

your network, as well as the effectiveness of your BigFix deployment. Next to the titles of each, there is a 

bracketed question mark [?], which you can click for additional information.  

NOTE: Reports will be disabled if a user is logged in without sufficient privileges to view them, or if the report is 
filtered. Users are not considered to have sufficient privileges unless they have full rights to all the 
computers on the server.  

The following sections describe each of the graphs, charts, and tables presented in the Overview. 

Total Issues 

The Total Issues graph adds the number of relevant Fixlets for each computer and then groups the issues by 

their severity rating. An issue is a Fixlet message that is relevant on any computer in your network. For 
example, if you have a computer with 5 relevant Fixlet messages and a second computer with 3 relevant Fixlet 

messages, the total number of issues is 8, even if some of those messages are the same. 

This graph can be set to different time granularities by selecting from the pull-down menu above the graph. 
The Auto-Fit Data option will automatically group the data in the graph for up to the last twelve months of 

your BigFix installation. Last 7 Days will group the data by day and show the last seven days. Last 30 Days 

will group the data by day and show the last thirty days. Last 26 Weeks will group the data by week and show 
the last six months. Last 52 Weeks will also group the data by week and show the last year. 

 

Different colored bars represent different issue severity. The height of each bar represents the number of issues 

for a particular bar. For example, if a bar for important issues starts at 300 and ends at 500, the total number of 

important issues is 200.  

Hover your cursor over any point in the 
graph to see a pop-up containing more 
detail. 
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Total Number of Computers 

The Total Number Of Computers graph displays the number of computers that have been under BigFix 

management in a given period of time. This graph offers a way to monitor additional deployments of the 

BigFix Client over time.  

 

Like the Total Issues graph, this graph will be disabled if a user logs in without sufficient privileges. Select the 

desired time scale from the pop-up menu above the chart. Move your cursor over specific data points for more 
information. 
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Computer Vulnerability Status 

The Computer Vulnerability Status pie chart groups computers according to their most severe vulnerability.  

  

If a computer has a Critical vulnerability, it will be considered to have critical status, regardless of other 
vulnerabilities it might possess. If a computer has no critical vulnerabilities, but has an Important 

vulnerability, it will be considered to have important status, etc., providing a general sense of how your 

network is doing. Initially, the vulnerability pie will be mostly red (critical), and as you continue to use BigFix, 
it will become green (no vulnerabilities). Hover your cursor over each pie slice to see the actual number of 

computers with each vulnerability state, and the percentage of network computers they represent. 
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Issues Remediated 

The Issues Remediated graph counts the number of computers that have returned Fixed in response to an 

action. The time segment for an action is pegged to its start time, not its completion time (which may occur in 

a subsequent time segment). This graph gives you a good picture of remediation rollouts across your enterprise 
as BigFix finds and fixes vulnerabilities. 

 

This is a historical graph. Select a time scale from the pop-up menu above the chart. This graph displays 

colored bars representing the severity of remediated issues, and lets you highlight data with your cursor. 

Overall Statistics 

The Overall statistics table displays important facts about your network: 

 

• Total Number of Computers: the current number of BigFix Clients.  

• Relevant Fixlets per Computer: the average number of relevant Fixlets per computer, or the total number 

of relevant issues divided by the total number of computers.  

• Total Number of Fixlets: the current number of Fixlets that exist on the BigFix system. Note that if Web 

Reports is looking across multiple databases in the network, the number of Fixlets will be the union of all 

the Fixlets in all the databases. 
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• Total Number of Fixlet Sites: the total number of sites to which the BigFix system is currently 

subscribed.  

• Total Number of Tasks: the current total of relevant tasks on your BigFix network. 

• Total Number of Analyses: the current total of Analyses that exist on the BigFix system.  

• Total Number of Actions: the current total of actions issued so far by the BigFix system.  

• Mean Time to Remediate: the average time it took for every relevant issue to become non-relevant on all 

computers. Note that issues may become non-relevant by methods other than actions. For example, users 

can manually update their computers, making those relevant issues no longer relevant. 

Top 10 Critical/Important Issues Detected 

The Top 10 Critical/Important Issues Detected report displays Fixlet messages that are currently affecting 

the largest number of computers on the network.  

 

There are four columns in this list: 

• The Name column lists the name of the Fixlet message. 

• The Source Severity column lists the severity of each common Fixlet. 

• The Affected Computers column displays the number of computers that currently have the Fixlet 

relevant. The Fixlet list is sorted by the Affected Computers count.  

• The Patch Completion column is the percentage of fixed computers out of the total number of computers 

that have ever been affected by the listed Fixlet.  
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Beneath the list of the top 10 most common issues, the Show Progress of Top 10 Critical/Important Issues 

link brings up a progress report.  

 

For each issue, the following information is displayed: 

• The name of the Fixlet message. 

• The number of computers affected by this issue. 

• The percentage of computers where BigFix has deployed the action. 

• The time and date when BigFix first detected the issue. 

• The mean time BigFix has taken to remediate this issue across your network. 

• A progress bar beneath each issue indicating the percentage of computers that have been remediated out 

of the total number affected.
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Managing Reports 

Click the Reports link to bring up the Report Management page. It has three main sections: Content Reports, 

Public Reports, and My Reports. 

You can sort tables and lists contained in the Reports page by clicking on their column headings. Clicking on 

the same column again will switch the order of the sort.  

You can designate Favorite reports that get listed in the Favorites box in the left navigation panel. Click the 
[add] or [remove] link in the Favorite column to switch the label between Yes (Favorite) and No. 

You can include links to External reports on this page. Click the Add External Link button, fill out the 

Report Name and Description, and add the full URL of the external report. The URL must start with http:// or 

https://.  

You can also import local reports. Click the Import button and specify a report file. Importing a report brings 

in the actual report rather than a link to a file. 
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Content Reports 

Content Reports are created by BigFix Sites and automatically distributed to Web Reports. There are five 

columns describing reports in this list: 

• The Name of the stored report. 

• The Sitename for the report. 

• The Category of the stored report, such as Enterprise Security, or Custom. 

• The Source of the stored report, such as Vulnerability Hotspot or Action Status. 

• The Favorite column lets you add or remove a report from your Favorites list. 

• The Copy column allows you to copy the report, in case you want to make minor changes. Copying brings 

the copied report into My Reports or Public Reports, depending on the visibility you select. 

Public Reports 

Public Reports are created by any Web Reports user and saved as Public. Web Reports only saves the 

templates; it generates the underlying data at report time.  

At installation, several reports are included in this section. The included reports are: 

• Action List 

• Analysis List 

• Computer Properties List 

• Open Vulnerabilities List 

• Operating System Distribution 

• Operator List 

• OS Vulnerability Summary 

• Progress of 10 Fixlets From Recent Actions 

• Progress of 10 Fixlets Recently Relevant 

• Vulnerabilities by Console Operators 

• Vulnerabilities by OS 

• Vulnerability Trends Over Time 

There are six columns describing reports in this list: 

• The first column consists of check boxes. If you want to delete a report, click the appropriate check box, 

then click Delete Reports. 

• The Name of the stored report. 

• The Category of the stored report, such as Action Summary, Fixlet Progress, or Computer Properties. 

• The Creator column lists the name of the BigFix Operator who created this report. 

• The Favorite column lets you add or remove a Report from your Favorites list. 
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• The last columns allow you to rename a stored report, if you are the report’s creator or a Web Reports 

administrator. Clicking rename brings up a new page allowing you to change the name, description and 

category of the report. If you have custom reports in this section, you can edit them if you are the creator 
or a Web Reports administrator. Clicking edit brings up the report’s Create page, so that you can edit its 

contents. 

My Reports 

The My Reports section of this page includes all reports you have created and saved, including test and 

sample reports. This section includes: 

• The first column consists of check boxes. If you want to delete a report, click the appropriate check box, 

then click Delete Reports. 

• The Name of the stored report. 

• The Category of the stored report, such as Single Retrieved Property Status or Test. 

• The Favorite column lets you add or remove a Report from your Favorites list. 

• The fifth columns allow you to rename or edit a stored report. Clicking rename brings up a new page 

allowing you to change the name, description and category of the report. Clicking edit brings up the 
report’s Create page, so that you can edit its contents. 
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Creating Reports 

You can create and customize report templates and use them to generate reports at any time. Click the Create 

tab to display the Create Report page.  
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Frequently Used Reports 

This set of reports is used for asset management, auditing and inventory, as well as monitoring the 

effectiveness and efficiency of your BigFix system. On the right-hand side of the page, there is a visual 

representation of the currently selected report. Click the buttons to get a quick overview of available reports. 

You can filter reports by computer properties and narrow them down by database, site, or computer. Reports 

can be viewed in printable format or exported as CSV (comma-separated values) to be viewed in a 

spreadsheet. 

This page organizes the reports into several categories: Computer, Retrieved Property, Analysis, Fixlet, Task, 

Baseline, Action, History, Unmanaged Assets, Operator, Hidden and Advanced. Each category has a set of 

predefined report types. To select a specific report, click the appropriate button, then click Next. A subsequent 

page will prompt you for any extra information needed for your report. The following sections discuss each 
report type and the parameters you need to specify. 

Computer Properties Report 

This report is one of the most powerful, useful, and resource-intensive BigFix reports available. You can group 
computers in the network by retrieved properties while summarizing other properties of individual computers.  
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To create the Computer Properties report: 

1. Select Create > Computer Properties. Click Next. 

2. To sort and group the data by specific properties, select from the lists in the Primary, Secondary, and 

Tertiary boxes. If you select no parameters, the report will list all computers in the network. 

1. If you are aggregating over multiple databases, select the Group by database box. 

2. If you wish to group computers based on their Computer Group, check the Group by computer 

groups box. 

3. Select the main property or properties of interest for this report from the Summarize box. The values you 

select will be displayed next to the computer name in the listing. 

4. Check the Include relevant Fixlets box to display the list of relevant Fixlets for each computer. This 

gathers a large amount of data, and can be a very slow report to process. If this box is checked when the 

Hide individual computers box is checked, the Fixlets will also be hidden, and only the number of 
relevant issues for a computer will be displayed.  

5. Check the Include remediated Fixlets box to include remediated Fixlets and are no longer reporting 

relevance for this issue. 

6. Check the Hide individual computers box if you want to suppress the individual computer names in the 
report.  

If this box is checked, just the number of computers in each retrieved property group will be listed and the 

Summarize properties will be ignored.  

7. Check the Hide individual Fixlets box if you want to see just the number of Fixlets, not each one. 

8. Check the Hide undefined results box if you want eliminate certain results from the report, such as error, 

none, not reporting, undefined, unknown or n/a. 

9. Click Next to generate the report. 

The report is displayed in a new page.  

10. Click the column headers to sort the items. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this 
report. 
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All Computers Report 

This report lists all the computers on your network, along with their computer ID, Database and Last Report 

Time. You can also search for computers. The search results display as a list. 

 

To view the All Computers report: 

1. Select Create > All Computers, and click Next.  

The report lists all the computers managed by BigFix, along with their name, ID, database, and last report 

time.  

2. Click on the name or ID of any computer to view the Single Computer Report. 

3. Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report. 
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Retrieved Property Report 

This report analyzes the value of a single computer attribute (retrieved property) across the BigFix network. 
The report displays as a table, illustrated by your choice of a pie or bar chart. Click on column headers to sort 

the list. Click on an entry in the Computer Name or Computer ID column to view a detailed report on that 

computer. 

 

To generate this report: 

1. Select Create > Single Retrieved Property Status. Click Next. 

2. From the scrolling list, select the name of the retrieved property you wish to summarize. 

3. Select a graph type (pie, bar or no graph) to be included in the report. For a pie chart or a bar graph, you 

will be able to customize the color set.  

4. Select the number of unique values you wish to label with a specified color. 

5. If you choose, customize the first 16 colors you wish to apply to the retrieved property values. 

6. Click Next to generate the report.  

Your report appears, listing the unique values of the retrieved property and the number of computers 

reporting each value. If your report contains a graph, only the first 15 values in the list are graphed 
independently; the rest of the results are combined into a 16th value. The default sort is by descending 

count or percent, forcing the first 15 values to be the biggest and presumably most important. You can 

click on a column heading to sort the table.  
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7. Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this 

report. 

NOTE: Since a computer can have multiple values for a single retrieved property, the total number of results 

listed can be larger than the number of computers on the network.  

You can also run this report by clicking on the link for a retrieved property in any other report. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this 
report. 

All Analyses Report 

This report lists all the Analyses that are available to your BigFix system. You can sort the list by Name, 

Sitename, Database, Activated By, Time Activated, and Status. 

 

To create the All Analyses report: 

1. Select Create > All Analyses. Click Next. 

A report is generated, listing all analyses. 

2. Click on any individual link in the Name to bring up an in-depth report on that analysis. 

3. Click on any link in the Activated By column to see all analyses activated by that user. 

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report. 
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All Fixlets Report 

This report lists all Fixlet messages that are available to the BigFix system. The report headers include Name, 
Sitename, Fixlet ID, Affected Computers, Remediated Computers, Deployed Actions, Download Size, and 

Source Severity. 

 

To create the All Fixlets report: 

1. Select Create > All Fixlets. Click Next. 

A report is generated, listing all Fixlet messages across your BigFix database servers.  

2. The column headers include those based on your default user settings. Sort the list by clicking on any 

desired column heading. 

3. Click on any individual Fixlet message to bring up an in-depth report. 

4. Click on any link in the Affected Computers, Remediated Computers, or Deployed Actions column to see 

a detailed report. 

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report. 
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Relevant Fixlets Report 

This report is similar in form to the All Fixlets report, but it displays only those Fixlet messages that are 
relevant on at least one BigFix-managed computer. 

 

To create the Relevant Fixlets report: 

1. Select Create > Relevant Fixlets. Click Next. 

A report is generated, listing all relevant Fixlet messages across your BigFix installation.  

2. Sort the list by clicking on any desired column heading.  

The column headers are based on your default user settings.  

3. Click on any individual Fixlet message to bring up an in-depth report. 

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report. 



BigFix Enterprise Suite Web Reports User's Guide Page 21 

Creating Reports 

  © 2009 by BigFix, Inc. 

Issue Assessment Report 

This report displays the affected and remediated computer counts for a selected Fixlet or group of Fixlets. 
You can group the report by properties, database or computer groups. For each Fixlet, there is a list of 

computers with columns including Subnet Address, Affected Count, Remediated Count, Total Count, and 

Percent. 

 

To create the Issue Assessment report: 

1. Select Create > Issue Assessment. Click Next. 

2. From the displayed page: 

a. Select primary, secondary, and tertiary retrieved properties to help you group the issues in the list. 

b. Check the appropriate box if you want to Group by database. 

c. Check the appropriate box if you want to Group by computer groups. 

d. Check the Show all subtotal and total counts box to show totals for different groups of 
computers.  

If computers are not grouped by any properties, this step will have no effect. 

e. Select the desired Fixlet sites you wish to include in the report. If you don't select any particular 
site(s), the report will include all of them. 

f. Select the desired Fixlet message(s) from the list.  

Use Ctrl- and Shift-click to select a group of Fixlet messages.  

g. Click Next to generate the report. 

The report will generate, listing each Fixlet message sorted by Fixlet Name. The report displays the 

number of computers affected and remediated by each Fixlet.  

3. Click on any Fixlet message for an in-depth report.  

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 
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Issue Compliance Report 

This report groups Fixlets and their targeted computers over selected time periods, allowing you to examine 
Fixlet histories by age ranges.  

 

To create the Issue Compliance report: 

1. Select Create > Issue Compliance. Click Next. 

2. From the displayed page: 

a. Select the desired Fixlet sites you wish to include in the report. If you don't select any particular 

site(s), the report will include all of them. 

b. Select the desired Fixlet message(s) from the list. Use Ctrl-Click or Shift-Click to select a group of 

Fixlet messages.  

c. For grouping the Fixlets, select the Primary and Secondary time periods, in days.  

d. Typical values are 7 and 30, providing three natural periods: within a week, between a week and a 

month, and greater than a month. 

e. Check the box to Hide individual computers to produce a summary. 

f. Click Next to generate the report. 

The report is generated, listing each Fixlet message, sorted by Fixlet Name.  

Click on any computer or Fixlet for an in-depth report. 

For each Fixlet, there are the following categories: 

• Remediated computers. This is the list of computers for which the Fixlet is no longer relevant. 
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• Less than the Primary period. This is the list of computers that have most recently been targeted by this 

Fixlet. 

• Between the Primary and Secondary period. This is the list of computers that became targeted during 

middle range of Fixlet aging. 

• Older than the Secondary period. This is the list of laggard computers, where a Fixlet has been relevant 

for a long time, but still not remediated. 

• Indeterminate period. Occasionally a Fixlet will have an unknown history, and this is the list of those 

computers. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 

Fixlet Progress Report 

This report displays the remediation progress of a specified Fixlet or group of Fixlets. For each Fixlet, it 

displays the number of computers affected, the detection date, the mean time for remediation and the 
percentage of computers that have been successfully remediated. 

 

To create the Fixlet Progress report: 

1. Select Create > Fixlet Progress. Click Next. 

2. From the displayed page: 

a. Select the desired Fixlet sites you wish to include in the report. If you don't select any particular 

site(s), the report will include all of them. 

b. Select the desired Fixlet message(s) from the list. Use Ctrl- and Shift-click to select a group of Fixlet 

messages.  

c. As well as manually selecting Fixlet messages from the list, you can automatically select a batch of 

Fixlets that have been acted upon. Enter the size of the batch and click the first Select button. The 
Fixlets in this range will be listed in the gray box to the right. 
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d. You may also select a batch of Fixlets that have become relevant. Enter the size of the batch and 

click the second Select button. The Fixlets in this range will be listed in the gray box to the right. 

The gray text box to the right contains a list of your current selections and reminds you if nothing has 

been selected.  

e. Click Next to generate the report. 

The report generates, listing the designated Fixlet messages. At the top of the report is the last refresh date.  

For each Fixlet, there are these lines of information: 

• The name of the Fixlet message. 

• The total number of computers targeted by this Fixlet message and the percentage of them that have been 

remediated. 

• The date that the Fixlet was first detected. 

• The mean time for remediation. 

• A progress bar that turns green as more computers are remediated.  

Click on any Fixlet link for an in-depth report.  

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 

All Tasks Report 

This report lists all Tasks available to your BigFix system. For each Task, the report has a column for the 

Name, Sitename, Task ID, Affected Computers, Remediated Computers, and Deployed Actions. 

 

To create the All Tasks report: 

1. Select Create > All Tasks. Click Next. 

A report is automatically generated, listing all the Tasks across all the BigFix database servers. 

2. Click on any individual Task to bring up an in-depth report. 

3. Click on a number in the Affected Computers or the Remediated Computers column to see a detailed 

report on the data. 

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report. 
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All Baselines Report 

This report lists all the Baselines in the BigFix system. For each Baseline, the report has a column for the 
Name, Sitename, Baseline ID, Affected Computers, Remediated Computers, and Deployed Actions. 

 

To create the All Baselines report: 

1. Select Create > All Baselines. Click Next. 

A report is automatically generated, listing all the Baselines across all BigFix databases. 

2. Click on any Baseline to bring up an in-depth report. 

Use the Current Report box in the left panel to Filter, Store, Export, Print, or Email this report. 

Action Summary Report 

This report lists the actions that have been issued, grouped by BigFix Operator. For each action, the report has 
a header for the Action ID, Name, Database, Status, Source Type, Sitename, Reported, Operator, and 

Start Time. Depending on your Report options, you may also have columns like Expired, Fixed, or Pending 

Offer Acceptance. 

 

To create the Action Summary report: 

1. Select Create > Action Summary. Click Next. 

2. From the displayed page: 
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a. From the list box, select any subset of BigFix operators to be in your report by Ctrl- and Shift-clicking 

on them (only those operators who still have open actions are listed).  

b. Check the boxes to include a column for each desired action status from those currently applicable. 

These may include Expired, Failed, Fixed or Pending Offer Acceptance. 

c. Click Next. 

All open actions are listed. You can sort the list by clicking the column headers.  

3. Click on an Action ID link for a detailed report on that particular action. 

4. Click on a Fixlet Name  link for more information. 

5. Click on an Operator link to generate a new report for that particular operator. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 

Fixlet History Report 

This report lets you analyze the history of specific Fixlet messages by displaying a graphical representation of 
the progress of a Fixlet or set of Fixlets over time. The graph depicts both the number of affected computers 

over time and those computers that have regressed (become affected again). You can choose to group 

computers hourly or daily. 

 

To create the Fixlet History report: 

1. Select Create > Fixlet History. Click Next. 
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2. To select the Fixlet sites to include in this report, select any Fixlets from the Fixlet list by Ctrl- and Shift-

clicking on them. 

3. Group your computers by the hour or the day using the buttons at the bottom of the page. 

A graph displaying the number of computers affected by these Fixlets over time appears. The y-axis 

corresponds to the number of computers and the x-axis corresponds to the date. The chart also displays the 

number of regressed computers (where the Fixlet has become relevant again). 

Below the graph are a couple of pull-down menus that let you reset the starting and ending dates of the 

charted time period. Fixlets are listed after the date options. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 

Relevant Issue History Report 

This graphical report allows you to visualize the effectiveness of your BigFix system over time. You set a time 

period, and choose to see data over an hour, day, or week. 

 

To create the Relevant Issue History report: 

1. Select Create > Relevant Issue History. Click Next. 

2. From the two pull-down menus: 

a. Select the starting and ending date for the period of interest.  

b. Select an averaging period from the three choices: hour, day or week.  
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c. Click Next. 

A graph appears, displaying the number of relevant issues and computers over time. The vertical scale 
corresponds to relevant issues.  

3. Click on any data point in the graph to display a text box with more details.  

The data appears in tabular form, below the graph. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 

Average Relevant Issue History Report 

This report is similar to the Relevant Issue History report. It divides the relevant Fixlet messages by the total 

number of computers in order to get an average.  

 

To create the Average Relevant Issue History report: 

1. Select Create > Average Relevant Issue History. Click Next. 

2. From the two pull-down menus, select the starting and ending date for the period of interest. 

3. Select an averaging period:  

• Hour 

• Day 

• Week 

Click Next. 

A graph appears, displaying the average number of relevant Fixlets per computer over time.  

4. Click on data points to see details.  
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Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this report. 

Unmanaged Assets List  

This report displays data on unmanaged assets gathered from a third-party source.  

 

To create the Unmanaged Assets List: 

1. Select Create > All Unmanaged Assets. Click Next. 

2. Select the columns you wish to monitor for each unmanaged asset. Click Next. 

A list of unmanaged assets is automatically generated.  

3. Click on an Asset ID to bring up the Single Unmanaged Asset report. 

Use the Current Report box in the left panel to Configure, Store, Export, Print, or Email this report. 

All Operators Report 

This report will list all operators, along with their privilege type, creation time, last Console login time, count 

of administrable computers, and count of deployed actions. 

 

To create the All Operators report: 

1. Select Create > All Operators. Click Next. 

A list of all operators is automatically generated. Filtering the report will affect the computer and action 

counts.  
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2. Click on an operator to bring up the Single Operator report. 

Use the Current Report box in the left panel to Configure, Store, Export, Print, or Email this report. 

Hidden Items Report 

This report displays all Fixlet messages, Tasks, Analyses, and Baselines that have been globally hidden 

through the Console.  

 

To create the Hidden Items report: 

1. Select Create > Hidden Items. Click Next. 

A report is automatically generated, listing all the hidden Fixlets, Tasks, Analyses and Baselines across all 

the BigFix database servers.  

2. Sort the list by clicking on any desired column heading. 

The column headers are based on your default user settings.  

3. Click on any individual item to bring up an in-depth report. 

Use the Current Report box in the left panel to Configure, Store, Export, Print, or Email this report. 

Blank Report 

This report lets you name, describe and categorize a custom report. A report like this is actually code that 

generates a printable report. It typically consists of HTML with embedded Relevance commands. You can 
choose to make this report public or private. For more information on creating a custom Blank Report, see the 

Advanced Topics section at the end of this guide. 
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Additional Reports 

BigFix Web Reports includes several reports that are used less frequently. This section presents those reports. 

Single Computer Report 

This report presents information about any specific computer on your network. You access this report by 
clicking on a computer name or ID in any list or report.  

 

The report contains the following information: 

• The Name of the computer. 

• The name of the Database corresponding to this computer. 

• The ID of the computer, as defined internally by BigFix. 

• Retrieved Properties: These are computer attributes that have been retrieved from the BigFix Client. This 

list is sortable by Name and Value; just click on the appropriate header. Click on an item in the Name 
column to bring up a report on that retrieved property, displaying the distribution of that attribute 

throughout your network. Click on an item in the Value column to bring up a report listing other 

computers with that particular value. 

• Client Settings: These are special retrieved properties used by the BigFix system. 

• Relevant Fixlets: This list can be sorted by clicking on the column headers. Click on individual Fixlet 
messages for more details. Click on an entry in the Affected Computers column to show the other 

computers that are also targeted by this Fixlet. 

• Remediated Fixlets: These are Fixlets that are no longer reporting as relevant. 

• Action Results: This is a list of the Actions that have been initiated on this computer, along with their 

disposition. You can sort the list by clicking on the column headers. 

• Analyses: These are all the Analyses that this computer is a part of, along with the current status of each. 

• Comments: Comments that have been entered for this computer. 

You can sort the report by any of these lists by clicking on the column headings. Use the Current Report box in 

the left panel to Configure, Store, Export, Print, or Email this report. 
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Computers with a Retrieved Property Value 

This report is available by clicking on the value of a Retrieved Property in any list or report. For a given 
value of a retrieved property, there will be a list of computers.  

 

This report has the following sections: 

• A title based on the name and the value of the retrieved property. 

• A list of computers.  

Click on the column headers to sort the list. Click on an entry in the Computer Name or Computer ID column 

to see a detailed report on that computer. 

Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this 

report. 
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Single Analysis Results Report 

This report displays information about any specific analysis. You access this report from the All Analyses 

Report by clicking on any desired analysis in the list.  

 

The report has the following sections: 

• A display of the analysis properties: Name, Sitename, Database, Issuer, Time Issued, and Status. 

• A link to the description of the original analysis. 

If the analysis is activated on any computers in your network, there will a link to view those computers. 

• A table listing the results of the analysis across your network, including the computer count and percentage 

for each result. 

• Any comments written by operators regarding this analysis. 
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Single Analysis Computers Report 

This report lists all computers associated with any specific analysis, along with their properties. Access this 
report by clicking the View Computers link in the Single Analysis Report.  

 

This report contains the following sections: 

• The same analysis properties as in the Single Analysis Report. 

• A Description of the report. 

• A link back to the Single Analysis Results Report. 

• A list of Analysis results, grouped by computer.  

There may be multiple results for an Analysis; if so, the report will show a column for each result.  
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Single Fixlet Report 

This report provides information about any specific Fixlet. Access this report by clicking on any Fixlet link 
available in a report, such as the All Fixlet List or Relevant Fixlets.  

 

The report has the following sections: 

• A display of the Fixlet message properties, including its Category and Severity as determined by the 

author of the Fixlet message.  

• A progress bar.  

If the Fixlet action has already been initiated, a real-time progress bar displays the current state of the 

deployment across the network. At zero percent compliance, the bar is gray. As computers are remediated, 

a green progress bar moves from left to right. 

• A list of all the Affected Computers that are currently reporting relevance for this Fixlet.  

• A list of Remediated Computers represents computers that were once affected, but are now fixed. 
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Note: Even when a patch is applied independently of the BigFix system, that computer will still be recognized 

as remediated and will be listed in this report. 

• A list of all open Actions—those that have already been issued and are still in progress for the given Fixlet 

message.  

• A list of Operator Comments. 

• A column displaying the Visibility of the Fixlet for various databases. 

You can sort any of these lists by clicking on the column headings. Use the Current Report box in the left 

panel to Filter, Configure, Store, Export, Print, or Email this report. 

Single Task Report 

This report provides information about any specific Task. It can be accessed by clicking on any Task link in a 

report, such as the All Task List.  

 

The report has the following sections: 

• A display of Task properties, including its category and severity (as determined by the author of the 

Task).  
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• A display of Affected Computers, a list of all the computers that are currently reporting relevance for and 

no longer reporting relevant.  

Note: Even when a patch is applied independently of the BigFix system, that computer will still be recognized as 
remediated and will be listed in this report. Unlike Fixlet messages, Tasks are often designed to implement 
a policy, not fix vulnerabilities. As such, a Task might never expire and remediation may be largely 
irrelevant. 

• A list of all open Actions—those that have already been issued and are still in progress for the given Task.  

• Comments by various operators about the Task. 

• A column displaying the Visibility of the Task for various databases. 

You can sort any of these lists by clicking on the column headings. Use the Current Report box in the left 

panel to Filter, Configure, Store, Export, Print, or Email this report. 

Single Baseline Report 

This report provides information about any specific Baseline. It can be accessed by clicking on any Baseline 

link available in a report, such as the All Baseline Report.  

 

The report has the following sections: 

• A display of Baseline properties, including name, sitename, source, and creator. 

• A display of the Components making up the Baseline. These are typically groups of Fixlets, Tasks and 

other Baselines. 

• A display of Affected Computers—those computers that are currently reporting relevance for this 

Baseline.  

• A list of Remediated Computers representing computers that were once affected by some component of 

this Baseline, but are now fixed.  

Note: Even when a patch is applied independently of the BigFix system, that computer will still be recognized as 
remediated and will be listed in this report. 
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• A list of all open Actions—those that have already been issued and are still in progress for the given 

Baseline.  

• Comments by various operators about the Baseline. 

You can sort any of these lists by clicking on the column headings. Use the Current Report box in the left 
panel to Filter, Configure, Store, Export, Print, or Email this report. 

Action Status Report 

This report provides information on any one action. It lists the computers on which the action was performed, 
and the status of the action on the computer. To access this report, select any Action ID in a list or report.  

 

The report contains the following information: 

• A header including: Action ID, Action Name, Source Type, Status, Start time, and Operator.  

• A list of the Action Results by computer. You can sort the list by clicking on the column headers. Click on 

the individual computer links for more information. 

• Operator Comments. 

You can sort the list by clicking on the column headings. Use the Current Report box in the left panel to 
Filter, Configure, Store, Export, Print, or Email this report. 
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Single Operator Report 

This report is available by clicking on the Operator link in the All Operators report or the Action Summary 
report.  

 

It contains the following sections: 

• Information about the operator: Name, Type (Master Operator or Operator), Creation Time, Last Login 

Time, Custom Content (Enabled or not) and the operator’s Email address. 

• A list of computers the operator has administrative privileges on. 

• A list of all Actions that the operator has deployed. 

• A list of all Fixlets the operator has created. 

• A list of all Tasks the operator has created. 

• Comments made by this operator. 
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Filtering Reports 

The Current Report box is available in the left navigation bar when a report displays. 

 

At the top of the panel is a drop-down menu listing the existing filters and options. All administrators—not just 
the creator of the filter—have the ability to delete a filter from this list. Some options from the Current 

Report box are: 

• Filter Report: This drop-down menu lets you select from, add, and manage the list of existing filters. 

These filters will help to narrow down your reports to just the items of greatest interest to you. Each Filter 
shows the name of its author in parentheses. 

• Configure Reports: This interface allows you to edit the parameters of a report. From any report, click the 

Configure Report link in the action box. The report criteria are presented, enabling you to edit them. 

• Store Reports: You can save the criteria you used for a report. From any report, click the Store Report 

link in the Current Report box. To store a report, provide this information: 

• Report Name. Enter a name (less than 100 characters) for the report. This becomes a sortable field in 

the report list. 

• Description. Enter a short description (less than 1,000 characters) for the report. 

• Category. Enter a category for this report. The category should reflect the report type, such as Action 

Summary or Relevant Fixlets. 

• Visibility. Check a button to make the report Public or Private. 

• Export to CSV: Click on this to export your report to any program that can accept files in Comma 

Separated Value (CSV) format. You will be presented with an Open/Save dialog, allowing you to view or 
save the file. 

• Printable Version: This link enables you to format a report for printing. Select File > Print to output your 

report. 

• Email Report: This link allows you to email the current report. Email settings must be set up prior to 

using this feature. 

Creating Filters 

The Filter Report selection in the Current Report box includes options to create new filters and manage 

existing filters. Filters can be applied to any report, including the Overview. You can also select a previously 

saved filter and apply it to your current report. If another filter is already in use, BigFix Web Reports will 

combine the two filters.  

Build a filter by selecting properties with specific values and adding them to the filter. The properties and 

values will be filtered based on the current filter. For example, if a Fixlet Sitename filter is added for 'BES 
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Support'; then when you look at the values for Fixlet names, you will only see Fixlet messages from the 'BES 

Support' site. When you are satisfied with a filter, click Done to use the filter immediately. It will be lost if any 
of the navigation links are clicked. Click Save Filter to store a filter for future use. 

To create a report filter, you need to add or remove filter properties one at a time. The filter can be used, saved, 

or cleared at any time.  

There are several filters from which to choose: 

• Saved Filter. Select a previously saved filter.  

• Database. Filter reports by the specified database. 

• Site. Filter reports based on the site. 

• Computer. Filter reports based on computer properties such as Directory, Group, Last Report Time or 

Retrieved Property. 

• Fixlet / Task / Baseline / Analysis. Filter reports based on various properties, such as Name, Sitename, 

Category, Source, Severity, CVE, SANS, Comments or Source release date. 

To build a filter: 

1. Ensure the Current Report box is visible in the left context panel. You may have to click the vertical blue 

bar to open this panel.  

2. Select the Create Filter option from the pull-down menu. This will bring up the Create Filter page. 

 

3. On the Create Filter page:  

a. Select a filter class by clicking on the plus sign (+) next to it.  

Depending on which filter class you select, you will be presented with another page to pick the filter 
value. There may be a pull-down menu letting you choose to Include or Exclude the selected values. 

b. Click the plus (+) or minus (-) buttons to add or delete a property.  

c. If you change your mind, click the Back button to choose another filter. 

The program displays your selected filter, along with the other previously defined components of the filter.  

4. Continue adding properties and values until the filter is complete. 

5. When you are finished, choose one of the following options: 

• Click Done to use the filter immediately in the current report.  



BigFix Enterprise Suite Web Reports User's Guide Page 42 

Filtering Reports 

  © 2009 by BigFix, Inc. 

• Click Save Filter to save the filter for future use.  

• Click Clear Filter to start over. 

Managing Filters 

Filters are used to customize reports, allowing you to focus on any particular subset of the database. To view, 
modify, or delete a saved filter, click the Manage Filters option in the Filter Report drop-down menu. You 

will see a list of the existing filters, allowing you to modify any of them. All administrators—not just the 

creator of the filter—have the ability to edit, delete, or rename a filter from this list.  

 

To manage filters: 

1. Select Current Report > Filter Report > Manage Filters.  

2. Click the Expand All button to see the details of each filter.  

3. From the list of Filters, click the Edit link to modify the filter properties.  

4. Click the Delete link to delete a saved Filter. 

WARNING! If you delete a filter that is a part of an existing report, you may change the interpretation of that 

report and generate a larger than expected listing. 
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Scheduling Activities 

You can create Scheduled Activities to email and archive specified reports after a given time period or when 

certain conditions are met. This allows you, for instance, to receive automatic updates of critical Fixlets via 
email, or to regularly back up audit reports.  

 

The columns on the page include: 

• Select All: Places a checkmark in front of each Scheduled Activity in the list. 

• Clear All: Clears all the check marks on the list. 

• New: Allows you to create your own Scheduled Activity.  

• Edit: Allows you to edit the properties of the Scheduled Activity. 

• Enable: Allows the selected activity to perform on schedule. 

• Disable: Prevents the activity from running until enabled again. 

• Delete: Deletes the selected (checked) activities. 

A scheduled activity creates a report on a specified schedule. The interface has four sections, specifying the 

time range, the activity report, the activity trigger for the schedule, and the activity actions that should be 

taken.  

To schedule an activity: 

1. Click the Schedule link, and then click the New button. 

The Create Scheduled Activity page appears. 

2. Select a time range for the scheduled activity. This setting defines the window during which the schedule 
remains in effect. If you do not select an expiration time, the activity stays open-ended.  

3. In the Activity Report box: 

 

a. Select a report type: Report, Overview, or Alert. A report produces a detailed graphic/tabular output, 

an overview summarizes the information graphically, and an alert typically sends a report as an email. 
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b. Select a stored report from the pull-down menu. The menu includes all public and private reports to 

which you have access. 

c. Select either HTML or CSV format for your report. 

4. In the Activity Triggers box: 

 

a. Select how often to generate the report: during a specified interval, after every data refresh, or once.  

b. Enter any relevance conditions necessary for the report to run. 

c. Select whether to email or archive the report only when it has changed. 

d. Check the box labeled Include trigger information to embed the trigger criteria in the report itself. 
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5. In the Activity Actions box: 

 

a. Select to whom to email the report. 

b. Select to have the report attached or linked to the message.  

c. Select whether or not to archive the report.  

The number of archives can be limited by how old they are, how much size they take up, or how 

numerous they are.  

d. Enter any customized executable you want. 

Custom executables must reside in the correct directory (as specified in the registry). The default 

directory is: C:\Program Files\BigFix Enterprise\BES Server\BESReportsData\CustomExe.  

There are several reserved parameters that can pass information about the activity to the executable: 

o <activityname>: the scheduled activity's name  

o <reportfile>: the file containing the generated report  

o <activitycreator>: the scheduled activity's creator 

6. Click Submit. 
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Configuring Email Settings 

Click the Email tab to configure email settings. Only a Web Reports administrator can edit email settings. 

There are two buttons on this page: 

• Test: Lets you verify the email server settings by sending a test message.  

• Edit: Allows you to edit the email settings. 

This page also has a link to a list of Email addresses. Click this link to bring up a page that helps you to 

manage a list of email address. 

Editing Email Settings 

To edit email settings: 

1. Click the Email tab.  

2. Click Edit on the Email Settings page. 

3. Enter your SMTP server and the default domain.  

The default domain will be used when you do not specify the domain along with the email address (i.e. 
you do not add “@domainname.com” to the email address).  

Adding Email Addresses 

To add a new email address: 

1. Store frequently used email addresses by clicking the My Email Addresses link in the main Email 

Settings page.  

2. Click Add New Contact to add a contact’s name and email address. 

3. Click the New button to store an email address.  

This page also allows you to delete addresses: check the box next to the name and click the Delete button. 

4. When you finish with your list, click Done. 
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Managing User Accounts 

The User Management page has two different interfaces, depending on how you log on to the program. If you 

log on as a Web Reports Administrator, the full list of settings will be available, including user management. If 
you do not have an Administrator account, you will only be able to edit your own personal settings. To view 

the User Management page, click the Users tab. 

 

 The User Management page lists users in a table that contains links in the Options column: 

• Edit: This link allows you to edit the settings for the associated user. 

• Delete: This link lets you delete the associated user from the Web Reports list. You must be logged into 

Web Reports as an administrator to delete users. Note that you cannot delete your own account. 

There are two other links on this page: 

• Add New User: Brings up the Create User page, which prompts you to provide a password and define 

any user restrictions. 

• User Options: Brings up the User Options page, which allows you to restrict user access to certain Web 

Reports features. 
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Adding a New User 

To add a user to the Web Reports system, you must log on as an Administrator.  

Follow these steps to add a user: 

1. Select Users > Add New User.  

The Create User page appears. 

 

2. On the Create User page: 

a. Choose an appropriate Username and Password for the new user. Type the password twice to verify 

it. 

b. Select one of the four available buttons to grant privileges to the user: 

o Administrator: Grants top-level privileges, with the ability to create additional users and set 
database configurations. 

o Normal user: Grants ordinary privileges allowing the user to view the data, but not to create other 

users or set database configurations. 

o Restrict normal user by Console operator: Grants privileges dictated by the Console Operator. 

This restricts the user to those computers approved by a specified Client Administrator. 

o Restrict normal user by saved filter: Grants privileges based on a saved filter. This option will 
not show up if there are no saved filters to display. 

c. Check the box if you want to Restrict user to Read-Only mode.  

Restricting users to read-only mode means that the users cannot create reports, schedule activities, or 

save filters. 

3. Click the Add new user button. 
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Editing User Accounts 

When editing user accounts, different options are presented depending on whether you are editing your own 

settings or someone else's. If you are not logged in as an administrator, you cannot edit other users’ accounts, 

and your interface is limited to your private user page. To change the parameters of a user, select the Users tab, 
and then click the Edit link in the row of the desired user. 

 

Regardless of administrative privileges, if you are editing your own settings, you can: 

• Change your password. Click this button to bring up the Change Password page. Enter your old 

password, then enter your new password and confirm it. 

• Change your default settings. You can only access your own personal defaults, not those of other users. 

If you are logged in as an administrator, and editing a user other than yourself, can: 

• Change the user’s privileges. This allows you to grant the user administrative access or to filter the user’s 

view based on a specific Console user.  

• Change the user’s password. Click this button to bring up the Change Password page. Enter a new 

password and confirm it. 

Setting User Options 

You can set user options by clicking User Options from the User Management page.  

 

To change user options: 

1. Check the appropriate boxes for the selected Web Reports user: 

• Allow normal users to store public reports. This is on by default. If it is turned off, then non-

administrative users will not be able to save public reports, but they will still be able to access public 

reports and save private reports. 
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• Allow normal users to view custom reports created by other normal users. This is on by default. 

Custom reports created by the Admin are always viewable. 

• Allow normal users to create, edit, and import custom reports. This is on by default. If turned off, 

non-administrative users will not be able to create, edit, and import custom reports. 

• Allow normal users to view all filters. This is on by default. If turned off, non-administrative users 

will only be able to view filters they have created themselves. 

• Allow users restricted by Console operators to view all operators. This is on by default. If turned 

off, restricted Web Reports users will not be able to view other operators. 

• Allow users restricted by Console operators to view all local analyses. This is on by default. If 
turned off, restricted Web Reports users will not be able to view the local analyses. 

2. Set the rules for the required complexity of the Web Reports password.  

By default, passwords must be between 6 and 255 characters. You can change these limits, depending on 
your desired level of security. 

Changing User Privileges 

An Administrator can change the privileges of other Web Reports users.  

 

To change user privileges: 

1. Click the Users tab, and then select the Edit link associated with the desired user.  

2. Click the Change privileges button and follow these steps:  

3. Select from one of these four privilege levels: 

• Administrator. Grants top-level privileges, with the ability to create additional users and set database 
configurations. 

• Normal user. Grants ordinary privileges to view the data, but not to create other users or set database 

configurations. 
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• Restrict normal user by Console operator. Grants privileges dictated by the Console Operator. This 

restricts the user to those computers approved by a specified Client Administrator. 

• Restrict normal user by saved filter. Grants privileges based on a saved filter. This option will not 

show up if there are no saved filters to display. 

4. Check the appropriate box if you want to Restrict user to Read-Only mode.  

Restricting users to read-only mode means that the users cannot create reports, schedule activities, or save 
filters. 

Editing Your Own User Preferences 

User Preferences are available when you edit your own user account from the User Management page. This 

page allows you to customize your default options for BigFix Web Reports.  

 

 

To edit your user preferences: 

1. Click the Users tab. 

2. From the User Management page, click the Edit link associated with your account. 

3. Click the button labeled Change default settings. This button is only available when you are editing your 

own user account.  

A new page appears with several options for you to customize. 
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To customize your options: 

1. In Top Level Defaults: 

a. Set the initial page you see after logging in. By default, this is set to Overview.  

b. Choose whether to disable graphs in reports.  

c. Choose whether to always show filters minimized by default. 

d. Enter the number of results to see per page. The default is 100.  

2. In Fixlet List Report Defaults select which Fixlet properties you want to include in your reports.  

3. In Fixlet History Report Defaults: 

a. Enter the number of hours to skip when sampling points. 

The hours to skip while sampling points represents how many hours can elapse between data samples 

before disconnecting the corresponding points on the graph.  

b. Choose whether to select Connect all data points. If you select this option, the hours to skip 
parameter will be ignored.  

4. Click Submit to update and save your default settings. 
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Managing Databases 

You can manage the databases from which Web Reports aggregates information. Click on the Databases tab 

to bring up the Database Settings page. There are several links on this page:  

• Edit: Allows you to edit the settings for a selected Database. Brings up the Edit Database page. 

• Delete: Lets you delete the selected Database from the Web Reports aggregation. If you want to ignore 

the database but keep the database connection information available, you can disable the database. To 
disable a database, click its Edit link and check the Disable database box. 

• Validate: Checks the validity of the Database by running a connection test. 

• Add New Database: Lets you add a new Database into the aggregation group. 

• Validate All Database Connections: Lets you validate all of the aggregated databases. This link 

attempts to connect to all the databases and spawns a small window to monitor the progress. If a 

problem occurs, an error message is issued. If all goes well, a check-mark appears along with a message 
indicating success. 

• Database Options: Allows you to set options for a selected database. One option exists on this page: 

Disable relevance evaluation. It is unchecked by default. If checked, all relevance evaluation in custom 

reports and in any scheduled activities will be disabled. 

• Cache Settings: Displays information about the database cache in memory. It displays the last time the 

cache was written to a file on disk for each database. It also allows you to change how often the cache is 

to be refreshed. Finally, it gives the option of writing the cache to disk, and if so, how often it should be 

written to disk. 

• Refresh Cache: Starts a full refresh of the database cache. 

• View Errors: Allows you to view all recent errors that have occurred in the Web Reports system. These 

errors usually occur in the background and can affect the integrity of the data. They are usually related 

to connection problems or other problems with the database. Only an administrator may clear these 

errors. 

• Local Database Settings: Shows the local database DSN and the local BigFix Reporting Server. 

Adding a Database 

You can add other BigFix databases to your reports. This allows you to create aggregate reports covering 

hundreds of offices, each with thousands of computers.  

There are two authentication types from which to choose: 

• Windows Authentication is somewhat more complex to set up, but provides a more secure solution. To 

use Windows Authentication, the Windows domain user that Web Reports runs under must have 
credentials and access to the database. Web Reports runs as a service; it will run as the LocalSystem 

account by default. To run the Web Reports Server as a different user, log on to the Web Reports Server 

as a domain user with permissions on the database.  

• SQL Server Authentication is simple but less secure than Windows authentication because the 

username and password are stored in plain text in the registry. For this option, the username must refer 

to a SQL Server user with permissions on the database. A console user’s name and password will also 

work, but this method is equally insecure because the password is also stored in plain text in the registry. 
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To add a database: 

1. Log in as an administrator. 

2. Select Databases > Add New Database.  

3. Enter a Server Name that will be used to identify the database.  

4. Choose a method to connect to the database. If Use a default DSN-less connection is selected, enter the 

server IP. If Use a system DSN is selected, enter the DSN name of a system DSN that connects to the 
server. 

5. Choose the Authentication Type that will be used to connect to the database.  

At the bottom is the default Web Reports URL, which points to the Web Reports Server. 

6. If necessary, change the URL for your Web Reports Server. 

Because the server’s URL is established when installing the product, you will not need to change this 

setting unless you add a database to your installation. 

Editing Database Connection Settings 

The Edit Database page allows you to change connection settings and disable the database.  

To edit database connection settings: 

1. Select the Database tab and click the Edit link next to the desired database name.  

The Edit Database page is displayed. 

2. Choose a method to connect to the database: 

• If Use a default DSN-less connection is selected, enter the server IP.  

• If Use a system DSN is selected, enter the DSN name of a system DSN that connects to the server. 

3. Choose the Authentication Type that will be used to connect to the database.  

• Windows Authentication 

• SQL/Server Authentication.  

4. Enter the Web Reports URL, which defaults to the Web Reports Server.  

5. Click the Disable database checkbox to exclude this database from all reports. The status of this 

checkbox applies across all Web Reports users. 

6. Click Submit. 
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Advanced Topics 

This section presents tasks unlikely to be needed by the typical user, but which may be of use to advanced 

users with specific customization needs. 

Exporting Web Reports as PDF Documents 

Web Reports 7.1 and later has the ability to generate PDF format documents for printing or emailing. PDFs 

can be sent by clicking on the Email Report link or by setting the PDF format option when creating or 

editing a scheduled activity, or by simply exporting the report as a PDF document. 

Automatic Installation 

There are two Tasks in the BES Console that are designed to help you get started. Select the Task tab and 

search for the following Task IDs: 

 Task ID: 602: BES Web Reports: Enable PDF Reports - Part 1 of 2 

 Task ID: 603: BES Web Reports: Enable PDF Reports - Part 2 of 2 

Execute the Actions in these Tasks to automatically install the PDF generator. 

Manual Installation 

You may also install the PDF functionality manually on the server hosting the BESWebReportsServer 

service. Here’s how:  

1. Install Internet Explorer 7, if it is not already installed. 

2. Install Flash Player for Internet Explorer (32-bit version, even on an x64 machine). 

3. Add your Web Reports host to Internet Explorer's trusted sites list for the system account.  

4. In the registry:  

a. Add a key to HKEY_USERS\[User account running Web Reports 

service]\Software\Microsoft\Windows\CurrentVersion\Internet Settings\ZoneMap\Domains 

with the fully qualified domain name of your Web Reports host. For example, if you access 
Web Reports at http://bes.example.com and run Web Reports under the SYSTEM account, you 

would add the key HKEY_USERS\S-1-5-

18\Software\Microsoft\Windows\CurrentVersion\Internet 

Settings\ZoneMap\Domains\bes.example.com. 

b. Add a REG_DWORD value (under the key you just added) named http and set it to 2. 

c. Add a REG_DWORD value (under the key you just added) named https and set it to 2. 

5. Add a PostScript file printer named BES Web Reports Printer that prints to the port 
C:\Program Files\BigFix Enterprise\BES Server\BESReportsData\ArchiveData\__pdf\out.ps. 

6. Install the 32-bit (x86) version of GhostScript (version 8.60) from the site: 

http://pages.cs.wisc.edu/~ghost/doc/GPL/gpl860.htm. 

7. Append the following strings to the end of your PATH variable under "System variables" (Right-

click on My Computer, Properties, Advanced, Environment Variables).  

• For 32-bit versions of Windows:  

https://vpn.bigfix.com/index.php/,DanaInfo=wiki+Adding_a_File_Printer
http://pages.cs.wisc.edu/~ghost/doc/GPL/gpl860.htm


BigFix Enterprise Suite Web Reports User's Guide Page 56 

Advanced Topics 

  © 2009 by BigFix, Inc. 

 C:\Program Files\gs\gs8.60\bin;  

 C:\Program Files\gs\gs8.60\lib;  

• For 64-bit versions of Windows:  

 C:\Program Files (x86)\gs\gs8.60\bin;  

 C:\Program Files (x86)\gs\gs8.60\lib;  

8. Create the following registry string values (REG_SZ) in the HKLM\Software\BigFix\Enterprise 

Server\BESReports registry key.  

• PDFEnable: 1  

• PDFPrinterName: BES Web Reports Printer  

• PDFPostScriptPath:  

 For 32-bit versions of Windows: 
C:\Program Files\BigFix Enterprise\BES Server\BESReportsData\ArchiveData\__pdf\out.ps  

 For 64-bit versions of Windows: 
C:\Program Files (x86)\BigFix Enterprise\BES Server\BESReportsData\ArchiveData\__pdf\out.ps  

9. Restart Windows (this is necessary to ensure that the PATH variable changes are picked up). 

Registry Settings 

All settings are REG_SZ values in HKLM\Software\BigFix\Enterprise Server\BESReports: 

 Setup  

o PDFEnable (Set to "1" to enable PDF generation)  

o PDFPostScriptPath  

o PDFPrinterName  

 Logging  

o PDFLogPath  

 Default Header and Footer  

o PDFDefaultHeader  

o PDFDefaultFooter  

 Using an unprivileged user to render the report and generate the PDF  

o PDFUseUnprivileged (Set to "1" to use the account specified by the values below)  

 UnprivilegedUsername  

 UnprivilegedDomain  

 UnprivilegedPassword  

 Timeout Settings  

o PDFReportTimeout (in minutes, default 60)  

o PDFPrintTimeout (in minutes, default 60)  

 Internet Explorer post-rendering pause  

o PDFPause (in seconds, default 10, gives Flash components time to initialize before printing  
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Header / Footer Print Codes 

When printing a PDF file, you can specify header and footer information in the Page Setup dialog. 

 

The codes used in the Header and Footer fields of this dialog allow you to add information about the title, 

URL, date and more. The list of possible codes includes the following: 

&w Window title 

&u Page address (URL) 

&d Date in short format specified by Regional Settings in 

Control Panel 

&D Date in long format specified by Regional Settings in 

Control Panel 

&t Time in the format specified by Regional Settings in 

Control Panel 

&T Time in 24-hour format 

&p Current page number 

&P Total number of pages 

&& A single ampersand (&) 

&b Separates preceding and following text into different 

sections. Example:    left   &b   center   &b   right 

text Custom text (can be used in combination with printing 
codes) 

For more information on creating PDF Web Reports, see: Troubleshooting Web Reports PDF 

Generation  

https://vpn.bigfix.com/index.php/,DanaInfo=wiki+Troubleshooting_Web_Reports_PDF_Generation
https://vpn.bigfix.com/index.php/,DanaInfo=wiki+Troubleshooting_Web_Reports_PDF_Generation
https://vpn.bigfix.com/index.php/,DanaInfo=wiki+Troubleshooting_Web_Reports_PDF_Generation
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Blank Report 

This report lets you name, describe and categorize a custom report. A report like this is actually code that 

generates a printable report. It typically consists of HTML with embedded Relevance commands. You can 

choose to make this report public or private. For more information on creating a custom Blank Report, see 
the Advanced Topics section at the end of this guide.  

To create a custom report: 

1. Select Create > Blank Report. Click Next. The following screen will appear: 

 

2. Fill in the following sections: 

a. The Report Name, as it will be displayed in the report list. 

b. A short Description of the report. 

c. A Category for the report. Category names are typically short, descriptive titles, like Action 

Summary, Computer Properties or Relevant Fixlet messages. 

d. Click one of the buttons to make the report Public or Private. A Public report is available to be 

viewed by all BigFix Operators, and it will include your name as creator. A Private report is 

available only to you in the My Reports section. 

3. Paste a copy of the report in the large text box labeled Report. This will add your custom report to the 

list of available reports. 
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Use the Current Report box in the left panel to Filter, Configure, Store, Export, Print, or Email this 

report. 

HTTPS Configuration  

To provide more security to Web Reports, you can use HTTPS. First, you need to request a Secure Socket 
Layer (SSL) certificate from a vendor such as Verisign, and then you need to set a registry key with the 

location.  

To register a certificate, you need a valid configuration file. It should look like this example: 

[ req ] 

default_bits = 1024 

default_keyfile = keyfile.pem 

distinguished_name = req_distinguished_name 

attributes = req_attributes 

prompt = no 

output_password = mypasswrd 

 

[ req_distinguished_name ] 

C = US 

ST = California 

L = City 

O = BigCo 

OU = Development 

CN = Common 

emailAddress = janedoe@bigco.com 

 

[ req_attributes ] 

challengePassword = bigcopasswrd 

To use HTTPS: 

1. Install Open SSL. 

2. Save your configuration file as something like mynewconfig.conf, and issue your certificate request. 

This will also generate a private key (in the file named keyfile.pem). Use this command: 

openssl req - new -config "c:\mynewconfig.conf" > cert.csr 

3. Remove the password from your private key file: 

openssl rsa -in keyfile.pem -out nopwdkey.pem 

4. Create a certificate file: 

openssl x509 -in cert.csr -out cert.pem -req -signkey nopwdkey.pem -days 365 

5. Open up nopwdkey.pem in a text viewer, copy the contents, and paste them below the certificate in 

cert.pem.  

6. Save this file; it is your SSL certificate.  

Next, you need to store the path for this file in the registry and add or modify three sub-keys: one for the 

HTTPS flag, one for the location of the SSL certificate, and one for the HTTPS port number. 

1. Run Regedit and find the HKey Local Machine\Software\BigFix\Enterprise Client\Settings\Client key.   

2. Create a new sub-key of “Client” called _WebReports_HTTPServer_UseSSLFlag. 

mailto:janedoe@bigco.com
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If the key already exists, do not create a second one. 

3. Create a new string value (reg_sz) for the key _WebReports_HTTPServer_UseSSLFlag called “value” 
and set it to 1 to enable HTTPS. 

4. Create a new sub-key of “Client” called _WebReports_HTTPServer_SSLCertificateFilePath. 

If the key already exists, do not create a second one. 

5. Create a new string value (reg_sz) for the key  _WebReports_HTTPServer_SSLCertificateFilePath 
called “value” and set it to the full path name of the SSL certificate (cert.perm). 

6. Create a new sub-key of “Client” called _WebReportsHTTPServer_PortNumber. 

If the key already exists, do not create a second one. 

7. Create a new string value (reg_sz) for the key _WebReportsHTTPServer_PortNumber called “value” 

and set it to the port number you would like to use (typically 443). 

8. Restart the BESWebReports service. 

9. Edit any entries in the AGGREGATEDBY table in the bfenterprise database to reference the Web 

Reports URL using the https:// prefix instead of http://. 

The SSL certificate should be in standard OpenSSL PKCS7 (.pem) file format. If the certificate meets all of 

the trust requirements of the connecting browser, then the browser will connect without any intervention. If 
the certificate does not meet the trust requirements of the browser, then you will be prompted with a dialog 

asking if it is OK to proceed with the connection, and giving you access to information about the certificate.  

Typically, a trusted certificate is one that is signed by a trusted authority (e.g. Verisign), contains the correct 
host name, and is not expired. The .pem file is your SSL certificate, which you must obtain through your 

favorite CA. If you do not require authentication back to a trusted root, you can also generate a self-signed 

certificate using OpenSSL utilities. 

Logging Web Reports 

Setting up a log file can help you should you need to debug your installation of Web Reports. The name of 
the log file is stored in the registry.  

To specify the file location: 

1. Run Regedit and find the HKey Local Machine\Software\BigFix\Enterprise Server\BESReports key 
(on a 64-bit machine, you may need to dig down into the Wow6432Node).  

You will see some variables and pathnames used by Web Reports. You need to add two values to this 

key: one for the logging flag, and one for the filename.  

2. Create a new DWORD value named LogOn and set it to 1 to turn on logging. 

3. Create a new string value named LogPath and set it to the full pathname of your desired log file, e.g. 

“C: \fullpath\file.txt".  

The next time you launch Web Reports, a log of the session will be saved to the specified file. 
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Querying Using HTTP GET 

You can query and access Web Reports by using HTTP GET. Given the URL and port for the Web Reports 

program, pass the desired command in your browser address line. If you are already logged in to the 

program, you can access the main page with a URL: 

http://bigco.com:52312/webreports?page=Main 

In this example, bigco.com is your domain, 52312 is the default BES port, and page=Main describes the 

part of the program you wish to access. If you have not yet logged in, you can pass your Username and 
Password on the same line: 

http://bigco.com:52312/webreports?Username=myName&Password=myPassword&page=Main 

In addition to accessing various pages in the program, you can also evaluate relevance expressions by 

accessing a special page labeled EvaluateRelevanceOnly: 

http://bigco.com:52312/webreports?page=EvaluateRelevanceOnly 

&expr=number%20of%20BES%20Computers 

The relevance expression to evaluate here is expr=<relevance expression>. When passing information in a 

URL, you need to use URI encoding. Web Reports evaluates the expression and returns the answer as a 

snippet of XML: 

  <?xml version="1.0" ?> 

  <RelevanceEvaluationXML> 

    <answerlist> 

      <plurality>0</plurality> 

      <answer>37945</answer> 

    </answerlist> 

  </RelevanceEvaluationXML> 

In this example, Web Reports indicates that there is only one answer (plurality=0) and that answer is 

37,945—the number of computers in this installation. If you wanted to return a list of computers in the same 

installation, the plurality would be “1” and there would be a computer name inside each of 37,945 Answer 
tags. 

Querying Using SOAP 

You can also access Web Reports using SOAP. Most client libraries require the location of a Web Services 

Description Language (WSDL) file and method name and parameters to pass into the method. The WSDL 

file describes the network endpoints required to query the BigFix Database through Web Reports. You can 
find a sample file, relevance.wsdl, in the BigFix installation directory. This WSDL file defines 

relevanceExpr, which allows you to evaluate a relevance expression. If you installed BigFix to a folder 

named BigFix Enterprise, you would find the file in this directory: 

BigFix Enterprise\BES Server\BESReportsServer\wwwroot\soap 

The Registry contains the actual location for your particular installation: 

HKLM\SOFTWARE\BigFix\Enterprise Server\BESReports\Paths 

This registry key has a string value named wsdl that contains the pathname for the WSDL file. 
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The request includes a tag labeled relevanceExpr that contains the relevance expression number of BES 

computers. This is one of the operations defined in the relevance.wsdl file.  

Currently the only method that can be called is: 

GetRelevanceResult( String relevanceExpression, String username, String password ) 

PERL 

PERL code using the SOAP::Lite module that takes three arguments, Web Reports username, password, and 
relevance expression and prints the results of the call. 

use SOAP::Lite; 

 

#arguments: [hostname] [username] [password] [relevance expression] 

 

#hostname only, e.g. 'example.com' rather than 'http://example.com/webreports' 

my $host = $ARGV[0]; 

 

my $username = SOAP::Data->name('username' => $ARGV[1] ); 

my $password = SOAP::Data->name('password' => $ARGV[2] ); 

my $expr = SOAP::Data->name('relevanceExpr' => $ARGV[3] ); 

 

my $service = SOAP::Lite -> uri( 'http://' . $host . '/webreports?wsdl' ) 

    -> proxy( $host ); 

 

my $result = $service -> GetRelevanceResult( $expr, $username, $password ); 

 

if( $result->fault ) 

{ 

 print "faultcode: " . $result->faultcode . "\n"; 

 print "faultstring: " . $result->faultstring . "\n"; 

} 

else 

{     

    foreach my $answer ( $result->valueof( "//GetRelevanceResultResponse/a" ) ) 

    { 

        print $answer . "\n"; 

    } 

} 
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Raw SOAP Request and Response Format 

A SOAP request looks like: 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"  > 

  <env:Body> 

    <GetRelevanceResult 

xmlns="http://[webreportshostname]:[webreportsport]/webreports?wsdl"> 

      <relevanceExpr>names of bes computers</relevanceExpr> 

      <username>bigfix</username> 

      <password>bigfix</password> 

    </GetRelevanceResult> 

  </env:Body> 

</env:Envelope> 

A SOAP response looks like: 

<?xml version="1.0" encoding="UTF-8"?> 

<env:Envelope xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"> 

  <env:Body> 

    <GetRelevanceResultResponse 

"xmlns=http://[webreportshostname]:[webreportsport]/webreports?wsdl">  

      <a>Computer 1</a> 

      <a>Computer 2</a> 

      <a>Computer 3</a> 

    </GetRelevanceResultResponse> 

  </env:Body> 

</env:Envelope> 

Sample relevance expressions are available at the BigFix web site (www.bigfix.com). You can also consult 

your BigFix representative for more information. 

http://www.bigfix.com/
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Session Inspectors 

BigFix Console and BigFix Web Reports both depend on an in-memory session cache to provide an efficient 

view of your BigFix database. Due to their distinct environments, these two programs have some significant 

differences: 

BigFix Console BigFix Web Reports 

Does not maintain Fixlet History inspectors. Maintain Fixlet History inspectors. 

Current inspectors are designed to work in 
the BigFix Console only. 

Current inspectors do not work. 

Inspectors dealing with globally visible Fixlets 
are consistent across applications. 

Locally visible Fixlet messages return nothing. 

Works with only one BigFix Server. Works across multiple BigFix Servers. 

JavaScript EvaluateRelevance calls are 
instantaneous. 

JavaScript EvaluateRelevance calls generate an 
HTTP request, which incurs a round-trip penalty to 
the server. 

Links to Fixlet filters, computer groups, 
computers, Fixlets, tasks, and analyses work. 

Links to Fixlet filters and computer groups do not 
work. Links to computers, Fixlets, tasks, and 
analyses work. 

Displaying Web Reports from Content Sites 

Web Reports accepts a report format that can display reports from content sites, allowing new reports to be 
added, edited, or removed by Fixlet actions or Tasks. There are three basic report types: External, 

Template and Custom. The report file must be a valid XML file with an extension of .beswrpt. It has the 

form: 

The Name and Category tags correspond to the same-named columns in Report listings. The contents of the 
Description tag pop up when you click the help link [?] next to each individual report in the list. If these 

fields are left blank, Web Reports supplies a suitable default, depending on the type of the report. You 

cannot have a blank category tag. 

The Source field indicates the author of the report.  

The contents and the existence of the URLParameters and Data tags depend on the Type tag. The Type tag 

can be one of three case-sensitive strings: TemplateReport, CustomReport, or ExternalReport.  
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The .beswrpt file can also contain multiple reports in a single XML file: 

 <BESWebReports> 

   <BESWebReport> 

     . 

     . 

     . 

   </BESWebReport> 

   <BESWebReport> 

     . 

     . 

     . 

   </BESWebReport> 

 </BESWebReports> 

External Reports 

An External Report contains a URL pointing to another page, service or reporting engine. The report file is a 

simple wrapper containing the full URL of the destination. When you import an External Report, it appears 

in the Web Reports list like any other report. When you click on an External Report, it loads the target page 

into the browser.  

In this example, an External Report loads the BigFix home page:  

 <BESWebReport> 

   <Name>Example External Report</Name> 

   <Description> 

     BigFix Home Page 

   </Description> 

   <Type>ExternalReport</Type> 

   <Category>External Report</Category> 

   <Source>BigFix, Inc.</Source> 

   <Data> 

     http:// 

   </Data> 

 </BESWebReport> 

Note: An embedded URL is an absolute address and must start with http:// or https://. 

https://63.251.54.98/,DanaInfo=www.bigfix.com+
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Custom Reports  

You can create a Custom Report using HTML with JavaScript and embedded Relevance expressions. The 
Data tag contains the full report request in a character data (CDATA) block. The XML parser will not 

attempt to interpret a CDATA block as markup, so you do not have to escape your included HTML or 

JavaScript. 

The optional URLParameters tag can contain extra information for Web Reports to use, such as filters or 
CSV format. The entire parameter set is beyond the scope of this document. For more information see the 

BigFix Knowledge Base. 

A custom web report has the form:  

  <BESWebReport> 

    <Name>Example Custom Report</Name> 

    <Description> 

      A customized report, prints all computer names. 

    </Description> 

    <Type>CustomReport</Type> 

    <Category>Custom Report</Category> 

    <Source>BigFix, Inc.</Source> 

    <Data> 

      <![CDATA[ 

        <div>Computer Names</div> 

        <?Relevance names of bes computers?> 

      ]]> 

    </Data> 

  </BESWebReport> 

To override the title <div> tag in a Custom Report, use the following:  

 var titleDiv = document.getElementById( 'wr_titlediv' ); 

 titleDiv.className = 'my title class'; 

 titleDiv.innerHTML = 'my new title'; 

If you wish to add your own onload events, make sure you call the original Web Reports onload event 

afterward. For example, if you wish to invoke an hourglass, retrieval and pointer event when your custom 

page is loaded write:  

 window.onload = function() { hourglass(document.body); 

 RetrieveData(); pointer (document.body); } 

However, the previous example would overwrite the necessary default event to start up Web Reports. To 
avoid that problem, save the original event and add it to the end of your function list:  

 var oldonload = window.onload; 

 window.onload = function() { hourglass(document.body); 

 RetrieveData(); pointer(document.body); oldonload(); } 

This will ensure that the Web Reports UI shows up correctly.  
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Template Reports 

A Template Report is similar to an External Report, except that the base of the URL is assumed to be the 
Web Reports server. These reports are essentially the same as the native Web Reports. The information in 

this section is included for completeness; in general you will only need to use Custom or External reports. 

The Data tag does not exist for this report. Instead, it passes all its information in the URLParameters tag.  

For example, you might create this Issue Assessment report:  

 <BESWebReport> 

   <Name>Example Issue Assessment Report</Name> 

   <Description> 

     An example report.  Runs the Issue Assessment report with specific Fixlets, BES 

Support/129 and BES Support/173. 

   </Description> 

   <Type>TemplateReport</Type> 

   <Category>Issue Assessment</Category> 

   <Source>BigFix, Inc.</Source> 

   <URLParameters> 

     FixletParam=BES Support%2f129&amp;FixletParam=BES Support%2f173&amp;page=VAReport 

   </URLParameters> 

 </BESWebReport> 

In XML as in HTML, you need to escape the URL Parameter. 
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